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Chapter 1:

Introduction

The Divider IP core is a one-clock divider which completes one integer division every clock. It supports signed or
unsigned inputs and provides configurable output latency.

Quick Facts

Table 1-1. Divider IP Core Quick Facts

Divider IP Core Configuration

Core Requirements

FPGA Families Supported

LatticeECP3™

LatticeECP2/M

LatticeXP2™

Minimum Device Required

LFE3-17EA

LFE2-6E

LFXP2-5E

Targeted Device

LFE3-35EA-8FN672C

LFE2-35E-7F672C

LFXP2-30E-7F672C

Configuration

20-bit numerator, 10-bit denominator, 20 output latency

o Registers 828 828 886
Resource Utilization
LUTs 311 311 368
Slices 446 446 484
Configuration 24-bit numerator, 12-bit denominator, 12 output latency
o Registers 586 586 619
Resource Utilization
LUTs 409 409 442
Slices 409 409 431
Configuration 32-bit numerator, 32-bit denominator, 32 output latency
o Registers 3127 3123 3137
Resource Utilization
LUTs 1459 1459 1458
Slices 1791 1788 1791

Design Tool Support

Lattice Implementation

Lattice Diamond® 2.0

Synthesis

Synopsys® Synplify™ Pro for Lattice F-2012.03L

Simulation

Aldec® Active-HDL™ 9.1 Lattice Edition
Mentor Graphics® ModelSim™ SE 6.3F

Features

» Supports signed or unsigned numerator and denominator

* Supports numerator and denominator data width 4-64

* Supports forced positive remainder

» Supports configurable output latency

* Optional clock enable and data valid ports

Release Information

¢ Divider IP Core version 1.0

— Last updated May, 2012

Device Support
e | LatticeECP3, LatticeECP2M™, LatticeECP2™ and LatticeXP2 FPGA Families
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Key Concepts
The Divider IP core implements integer division with the formula:
Numerator = Denominator * Quotient + Remainder

Numerator and Denominator can be signed or unsigned integers. When either the Numerator or Denominator is a
signed integer, Quotient and Remainder will also be in signed integer format. When the Remainder is configured to
be “Always Positive Remainder”, the Remainder will be a positive signed integer value.

Block Diagram
Figure 2-1. Divider IP Core Block Diagram
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N stages

The Divider IP core uses a non-restoring division algorithm to implement the integer division operation.
There are N stages of 1-bit division in an integer division operation, where N is the width of the quotient.

Each stage generates a 1-bit quotient and partial-remainder. In the last stage, the final quotient and remainder are
generated. 1-bit division uses an adder-subtracter to compare the partial remainder and denominator to get a new
partial remainder. Quotient-digit selection is based on the sign of the partial remainder. In the last stage, the partial

remainder is corrected to get the final remainder.

The Divider IP core supports configurable output latency. The latency can be any number of clock cycles from 1 to
N. When latency is set to the value M, M stages of output registers are uniformly distributed into the N stages of 1-
bit division operation. The final division stage always has output registers.

Primary 1/0O
Figure 2-2. Divider IP Core I/O Diagram

rsthn ——p»|
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Divider
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dvalid_in - ---- » - P dvalid_out
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Functional Description

Table 2-1. Primary I/O Descriptions

Port Size I/1O Description
General 1/0Os
rstn 1 | Asynchronous active-low reset signal
clk 1 | Input clock
ce 1 I Clock enable, active high
dvalid_in 1 I Optional input data valid signal, active-high
numerator 4-64 I Input numerator value
denominator 4-64 | Input denominator value
dvalid_out 1 0] Optional output data valid signal, active high
quotient 4-64 (0] Output quotient
remainder 4-64 (0] Output remainder

Timing Specifications

The Divider IP core is a one-clock divider. It can accept a numerator and denominator every clock cycle and gener-
ate a quotient and remainder every clock cycle.

When the input numerator and denominator are in an unsigned format, the output quotient and remainder are in an
unsigned format. When either the numerator or denominator is in a signed format, the output quotient and remain-
der are always in a signed format.

Figure 2-3. Unsigned Integer Division with a Latency of 8
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dvalid_in J
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Figure 2-4. Signed Integer Division with a Latency of 8
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Functional Description

Figure 2-5. Signed Integer Division with a Positive Remainder
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=LATTICE Parameter Settings

This section describes how to generate the Lattice Divider IP core using the Diamond IPexpress™ tool. Refer to “IP
Core Generation” on page 9 for a description of how to generate the IP core.

The Divider configuration GUI is accessed via the IPexpress tool and provides an interface for setting the desired
parameters and invoking the IP Core Generator. Since the values of some parameters affect the size of the core,
the maximum value for these parameters may be limited by the size of the target device. Table 3-1 provides a list of
user configurable parameters for the Divider IP core.

Table 3-1. Divider IP Core Parameters

Parameter Range/Options Default
Structure
Numerator data type Unsigned, Signed Unsigned
Denominator data type Unsigned, Signed Unsigned
Numerator data width 4-64 20
Denominator data width 4-64 10
Output latency 1-64 20
Always positive remainder Yes, No No
Clock enable port Yes, No No
Data valid ports Yes, No No
Synthesis Options
Frequency constraint (MHz) 1-400 250
Fanout limit 1-200 100
Resource sharing Yes, No Yes
Pipelining and retiming Yes, No No
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Implementation
The Implementation tab provides settings for Divider structure and synthesis options.

Figure 3-1. Implementation Tab

Implementation \

— Structure

MHumerator data type IUnsigned j

Drenominator data type IUnsigned j
Mumerator data width 20 [4-B4]
Denaminator data width 10 [4-64]

COutput latency 20 [1-20)

™| &lwaps positive remainder
[™ Clock enable port
[ Data valid ports

— Synthesiz Optionz
Frequency constraint (MHz): W [1-400)
Fanout limit: [to0 [1-z00)
¥ Resource sharing

[™ Pipelining and retiming

¢ Numerator data type specifies the data type of input Numerator.

e Denominator data type specifies the data type of input Denominator.

¢ Numerator data width specifies the data width of input Numerator.

e Denominator data width specifies the data width of input Denominator.

e Qutput latency specifies the output latency of the Divider core. lts value can be between 1 and Numerator data
width.

e The Clock enable port check box specifies whether the core has a clock enable port.
e The Data valid ports check box specifies whether the core has an input data valid and output data valid ports.

e Frequency constraint sets the required clock frequency in MHz. This option applies to all of the clocks in the
core.

¢ Fanout limit sets the fanout limit value for the synthesis tool.

e Resource sharing and Pipelining and retiming, if enabled, are synthesis directives that are used in the core
generation. Users can adjust these options to get better timing results.
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This section provides information on how to generate the Divider IP core using the Diamond IPexpress tool, and
how to include the core in a top-level design.

Licensing the IP Core

An IP core- and device-specific license is required to enable full, unrestricted use of the Divider IP core in a com-
plete, top-level design. Instructions on how to obtain licenses for Lattice IP cores are provided on the Lattice web-
site: www.latticesemi.com/products/intellectualproperty/aboutip/index.cfm.

Users may download and generate the Divider IP core and fully evaluate the core through functional simulation and
implementation (synthesis, map, place and route) without an IP license. The core supports Lattice’s IP hardware
evaluation capability, which makes it possible to create versions of the IP core that operate in hardware for a limited
time (approximately four hours) without requiring an IP license. See “Hardware Evaluation” on page 14 for further
details. However, a license is required to enable timing simulation, to open the design in the Diamond design soft-
ware and to generate bitstreams that do not include the hardware evaluation timeout limitation.

Getting Started

The Divider IP core is available for download from the Lattice IP Server using the IPexpress tool. The IP files are
automatically installed using ispUPDATE technology in any user-specified directory. After the IP core has been
installed, the IP core is available in the IPexpress GUI dialog box shown in Figure 4-1. To generate a specific IP
core configuration, the user specifies:

* Project Path — Path to the directory where the generated IP files will be located.
* File Name — “username” designation given to the generated IP core and corresponding folders and files.
* Module Output — Verilog or VHDL.

* Device Family — Device family to which IP is to be targeted. Only families that support the particular IP core are
listed.

* Part Name — Specific targeted part within the selected device family.

Configuring the Divider IP Core in IPexpress

The Divider IP core configuration GUI is accessed via the Diamond IPexpress tool, and provides an interface for
setting the desired parameters and invoking the IP core generator. The start-up IPexpress page allows the user to
select the IP core to be generated, the project directory, the user designated module name, the design entry type,
and the target device. The “File Name” will be used as the username in the IP core generation. The Divider IP core
is found in IPexpress under IP > DSP, as shown in Figure 4-1.

IPUG108_01.0, June 2012 9 Divider IP Core User’s Guide
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IP Core Generation

Figure 4-1. IPexpress Dialog Box
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Important Note: File Name cannot be set to “divider_core,” as this name has been used in the internal design of the
IP core.

Note that if the IPexpress tool is called from within an existing project, Project Path, Module Output, Device Family
and Part Name default to the specified project parameters. Refer to the IPexpress tool online help for further infor-
mation.

To create a custom configuration, the click the Customize button in the IPexpress tool dialog box to display the
Divider IP core Configuration GUI, as shown in Figure 4-2. From this dialog box, the user can select the IP param-
eter options specific to their application.
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IP Core Generation

Figure 4-2. Configuration GUI
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IPexpress-Created Files and Top Level Directory Structure

When the user clicks the Generate button in the IP Configuration dialog box, the IP core and supporting files are
generated in the specified Project Path directory. The directory structure of the generated files is shown in Figure 4-
3. This example shows the directory structure generated for the Divider IP core for a LatticeECP3 FPGA.

Figure 4-3. Lattice Divider IP Core Directory Structure

=] test
= divider_eval
= divider
= impl
precision
synplify
=l sim
= aldec
ri
scripts
timing
= modelsim
ri
scripts
timing
=l sre
= beh_rtl
ecp?
params
= ri
B . top
ecp?
testbench

Table 4-1 provides a list of key files and directories created by the IPexpress tool and how they are used. The IPex-
press tool creates several files that are used throughout the design cycle. The names of most of the created files
are customized to the user's module name specified in the IPexpress tool.

Table 4-1. File List

File Description

This file contains the IPexpress tool options used to recreate or modify the core in the IPexpress
tool.

The IPX file holds references to all of the elements of an IP core or module after it is generated
from the IPexpress tool. The file is used to bring in the appropriate files during the design imple-
mentation and analysis. It is also used to re-load parameter settings into the IP core/module
generation GUI when an IP core/module is being regenerated.

<username>.lpc

<usernames.ipx

<username>.ngo This file provides the synthesized IP core.

<username>_bb.v This file provides the synthesis black box for the user’s synthesis.
<username>_inst.v This file provides an instance template for Divider IP core.
<username>_beh.v This file provides the front-end simulation library for Divider IP core.

Table 4-2 provides a list of key additional files providing IP core generation status information and command line
generation capability are generated in the user's project directory.
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IP Core Generation

Table 4-2. Additional Files

File Description

This file is created when the GUI Generate button is pushed. This file may be run from the com-

< rname> nerate.tcl ;
username>_generate.tc mand line.

<username>_generate.log  |This is the synthesis and map log file.

<username>_gen.log This is the IPexpress IP generation log file.

Instantiating the Core

The generated Divider IP core package includes black-box (<username>_bb.v) and instance (<username>_inst.v)
templates that can be used to instantiate the IP core in a top-level design. An example RTL top-level reference
source file that can be wused as an instantiation template for the IP core is provided in
\<project_dir>\divider_eval\<username>\src\rtl\top. Users may also use this top-level reference as the starting
template for the top level of their complete design.

Running Functional Simulation

Simulation support for the Divider IP core is provided for the Aldec Active-HDL (Verilog and VHDL) simulator and
the Mentor Graphics ModelSim simulator. The functional simulation includes a configuration-specific behavioral
model of the Divider IP core. The test bench sources stimulus to the core and monitors output from the core. The
generated IP core package includes the configuration-specific behavior model (<username>_beh.v) for functional
simulation in the “Project Path” root directory. The simulation script supporting ModelSim evaluation simulation is
provided in \<project_dir>\divider_eval\<username>\sim\modelsim\scripts. The simulation script supporting
Active-HDL evaluation simulation is provided in \<project_dir>\divider_eval\<username>\sim\aldec\scripts.
Both Modelsim and Active-HDL simulation is supported via test bench files provided in
\<project_dir>\divider_eval\testbench. Models required for simulation are provided in the corresponding \models
folder.

Users may run the Active-HDL evaluation simulation by following the steps below:
1. Open Active-HDL.
2. Under the Tools tab, select Execute Macro.

3. Browse to folder \<project_dir>\divider_eval\<username>\sim\aldec\scripts and execute one of the "do"
scripts shown.

Users may run the ModelSim evaluation simulation by following the steps below:
1. Open ModelSim.

2. Under the File tab, select Change Directory and choose the folder <project_dir>\divider_eval\<username>
\sim\modelsim\scripts.

3. Under the Tools tab, select Execute Macro and execute ..\scripts\<username>_rtl_se.do.

Note: When the simulation is complete, a pop-up window will appear asking “Are you sure you want to finish?”
Choose No to analyze the results. Choosing Yes closes ModelSim.

Synthesizing and Implementing the Core in a Top-Level Design

Synthesis support for the Divider IP core is provided for Mentor Graphics Precision RTL or Synopsys Synplify. The
Divider IP core itself is synthesized and is provided in NGO format when the IP core is generated in IPexpress.
Users may synthesize the core in their own top-level design by instantiating the core in their top-level design as
described previously and then synthesizing the entire design with either Synplify or Precision RTL synthesis.
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IP Core Generation

The top-level file <username>_eval_top.v provided in \<project_dir>\divider_eval\<username>\src\top sup-
ports the ability to implement the Divider IP core in isolation. Push-button implementation of this top-level design
with either Synplify or Precision RTL synthesis is supported via the project files <username>_eval.ldf located in
the \<project_dir>\divider_eval\<username>\impl\synplify and \<project_dir>\divider_eval\<username>
\impl\precision directories, respectively.

To use this project file in the Diamond design software:
1. Choose File > Open > Project.

2. Browse to \<project_dir>\divider_eval\<username>\impl\(synplify or precision) in the Open Project dialog
box.

3. Select and open <username>.ldf. At this point, all of the files needed to support top-level synthesis and imple-
mentation will be imported to the project.

4. Select the Process tab in the left-hnand GUI window.

5. Implement the complete design via the standard Diamond GUI flow.

Hardware Evaluation

The Divider IP core supports the Lattice IP hardware evaluation capability, which makes it possible to create ver-
sions of the IP core that operate in hardware for a limited period of time (approximately four hours) without requiring
the purchase of an IP license. It may also be used to evaluate the core in hardware in user-defined designs.

Choose Project > Active Strategy > Translate Design Settings. The hardware evaluation capability may be
enabled or disabled in the Strategy dialog box. It is enabled by default.
Updating/Regenerating the IP Core

By regenerating an IP core with the IPexpress tool, the user can modify any of its settings including device type,
design entry method, and any of the options specific to the IP core. Regenerating can be done to modify an exist-
ing IP core or to create a new but similar one.

Regenerating an IP Core in Diamond

To regenerate an IP core in Diamond:

1. In IPexpress, click the Regenerate button.
2. In the Regenerate view of IPexpress, choose the IPX source file of the module or IP you wish to regenerate.

3. IPexpress shows the current settings for the module or IP in the Source box. Make your new settings in the Tar-
get box.

4. If you want to generate a new set of files in a new location, set the new location in the IPX Target File box. The
base of the file name will be the base of all the new file names. The IPX Target File must end with an .ipx exten-
sion.

5. Click Regenerate. The module’s dialog box opens showing the current option settings.

6. In the dialog box, choose the desired options. To get information about the options, click Help. Also, check the
About tab in IPexpress for links to technical notes and user’s guides. IP cores may come with additional infor-
mation. As the options change, the schematic diagram of the module changes to show the I/O and the device
resources the module will need.

7. To import the module into your project, if it's not already there, select Import IPX to Diamond Project (this is
not available in stand-alone mode).
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8. Click Generate.
9. Check the Generate Log tab to check for warnings and error messages.
10.Click Close.

The IPexpress package file (.ipx) supported by Diamond contains references to all of the elements of the generated
IP core required to support simulation, synthesis and implementation. The IP core may be included in a user's
design by importing the .ipx file to the associated Diamond project. To change the option settings of a module or IP
core that is already in a design project, double-click the module’s .ipx file in the File List view. This opens IPexpress
and the module’s dialog box showing the current option settings. Then go to step 6 above.
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Chapter 7:

Support Resources

This chapter contains information about Lattice Technical Support, additional references, and document revision

history.

Lattice Technical Support

There are a number of ways to receive technical support.

Online Forums

The first place to look is Lattice Forums (www.latticesemi.com/support/forums.cfm). Lattice Forums contain a
wealth of knowledge and are actively monitored by Lattice Applications Engineers.

Telephone Support Hotline

Receive direct technical support for all Lattice products by calling Lattice Applications from 5:30 a.m. to 6 p.m.

Pacific Time.

¢ For USA & Canada: 1-800-LATTICE (528-8423)
e For other locations: +1 503 268 8001

In Asia, call Lattice Applications from 8:30 a.m. to 5:30 p.m. Beijing Time (CST), +0800 UTC. Chinese and English

language only.

* For Asia: +86 21 52989090

E-mail Support

* techsupport@Ilatticesemi.com

* techsupport-asia@latticesemi.com

Local Support

Contact your nearest Lattice sales office.

Internet

www.latticesemi.com
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Appendix A:

=LATTICE Resource Utilization

This appendix gives resource utilization information for Lattice FPGAs using the Divider IP core.

IPexpress is the Lattice IP configuration utility, and is included as a standard feature of the Diamond design tools.
Details regarding the usage of IPexpress can be found in the IPexpress and Diamond help system. For more infor-
mation on the Diamond design tools, visit the Lattice web site at www.latticesemi.com/software.

LatticeECP3 Devices

Table A-1. Performance and Resource Utilization?

Numerator | Numerator | Denominator | Denominator Output

Data Type | Data Width | Data Type Data Width Latency Registers LUTs Slices fmAax
Unsigned 20 Unsigned 10 20 828 311 446 316
Unsigned 24 Unsigned 12 12 586 409 409 218
Signed 32 Signed 32 32 3127 1459 1791 248

1. Performance and utilization data are generated targeting a LFE3-35EA-8FN672C device using Lattice Diamond 2.0 and Synplify Pro F-
2012.03L software. Performance may vary when using a different software version or targeting a different device density or speed grade
within the LatticeECP3 family.

Ordering Part Number
The Ordering Part Number (OPN) for the Divider IP core targeting LatticeECP3 devices is DIVIDE-E3-U.

LatticeECP2M Devices

Table A-2. Performance and Resource Utilization?

Numerator | Numerator | Denominator | Denominator Output

Data Type | Data Width | Data Type Data Width Latency Registers LUTs Slices fmax
Unsigned 20 Unsigned 10 20 828 311 446 305
Unsigned 24 Unsigned 12 12 586 409 409 210
Signed 32 Signed 32 32 3123 1459 1788 232

1. Performance and utilization data are generated targeting a LFE2M35E-7F672C device using Lattice Diamond 2.0 and Synplify Pro F-
2012.03L software. Performance may vary when using a different software version or targeting a different device density or speed grade
within the LatticeECP2M family.

Ordering Part Number
The Ordering Part Number (OPN) for Divider IP core targeting LatticeECP2M devices is DIVIDE-PM-U.

LatticeECP2 Devices

Table A-3. Performance and Resource Utilization?

Numerator | Numerator | Denominator | Denominator Output

Data Type | Data Width | Data Type Data Width Latency Registers LUTs Slices fmAax
Unsigned 20 Unsigned 10 20 828 311 446 301
Unsigned 24 Unsigned 12 12 586 409 409 211
Signed 32 Signed 32 32 3123 1459 1788 217

1. Performance and utilization data are generated targeting a LFE2-35E-7F672C device using Lattice Diamond 2.0 and Synplify Pro F-
2012.03L software. Performance may vary when using a different software version or targeting a different device density or speed grade
within the LatticeECP2 family.
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= LATTICE

Resource Utilization

Ordering Part Number
The Ordering Part Number (OPN) for Divider IP core targeting LatticeECP2 devices is DIVIDE-P2-U.

LatticeXP2 Devices

Table A-4. Performance and Resource Utilization?

Numerator | Numerator | Denominator | Denominator Output

Data Type | Data Width | Data Type Data Width Latency Registers LUTs Slices fmax
Unsigned 20 Unsigned 10 20 828 311 446 281
Unsigned 24 Unsigned 12 12 586 409 409 211
Signed 32 Signed 32 32 3123 1459 1788 202

1. Performance and utilization data are generated targeting a LFE2M35E-7F672C device using Lattice Diamond 2.0 and Synplify Pro F-

2012.03L software. Performance may vary when using a different software version or targeting a different device density or speed grade
within the LatticeECP2M family.

Ordering Part Number
The Ordering Part Number (OPN) for Divider IP core targeting LatticeXP2 devices is DIVIDE-X2-U.
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@Iasﬂ U

KomnaHus ((3J'IeKTpO|_|J'|aCT» npeanaraeT 3akKn4vyeHmne onrocpoYHbIX OTHOLLIEHUN npu
NOoCTaBKaxX MMMNOPTHbIX 3NTEKTPOHHbIX KOMMOHEHTOB Ha B3aMMOBbLIFO4HbIX yCJ'IOBI/lFlX!

Hawwn npeumyuiectsa:

e OnepaTuBHbIE NOCTABKM LUMPOKOrO CMeKTpa 3NeKTPOHHbIX KOMMNOHEHTOB OTEYECTBEHHOIO U
MMMOPTHOrO NPON3BOACTBA HANPAMYO OT MPOM3BOAMTENEN U C KPYNMHENLLNX MUPOBbLIX
CKNaaos.;

MocTaBka 6onee 17-TM MUNIIMOHOB HAMMEHOBAHWUIN 3NEKTPOHHbLIX KOMMNOHEHTOB;

MocTaBka CNoXHbIX, AeULNTHBIX, MMOO CHATLIX C MPOM3BOACTBA NO3ULIUIA;

OnepaTtunBHbIE CPOKM NOCTABKM Nof 3aka3 (0T 5 pabounx gHewn);

OKcnpecc goctaska B Nnobyto Touky Poccuu;

TexHnyeckas nogaepkka npoekTa, NomMoLLlb B nogdope aHanoros, NocTaBka NPOTOTUMOB;

Cuctema MeHeXMeHTa KavyecTBa cepTuduumnposaHa no MexayHapogHomy ctaHgapTty 1ISO

9001;

o JlnueHausa ®CH Ha ocyulecTBneHne paboT ¢ NCNONb30BaHWEM CBEOEHUIN, COCTABAOLLINX
rocygapCTBEHHYIO TalHy;

o [locTaBka cneumnanmampoBaHHbIX KOMNoHeHToB (Xilinx, Altera, Analog Devices, Intersil,
Interpoint, Microsemi, Aeroflex, Peregrine, Syfer, Eurofarad, Texas Instrument, Miteq,
Cobham, E2V, MA-COM, Hittite, Mini-Circuits,General Dynamics v gp.);

MoMMMO 3TOro, O4HMM M3 HanpaBnNeHU koMnaHum «AnekTpollnacT» ABNseTca HanpaBneHne

«UcTouHmkn nutaHua». Mel npeanaraem Bam nomoub KoHCTpyKTOpCKOro otaena:

e [logGop onTuManeHOro peleHus, TexHn4eckoe 060CHOBaHME Npu BbIOOpPE KOMMOHEHTA;
Monbop aHanoros.;
KoHcynbTaumm no NpUMEHEHMIO KOMMOHEHTA;
MocTaBka 06pa3yoB M NPOTOTUMNOB;
TexHn4veckasn noaaepka npoekTa;
3awmTa OT CHATMSA KOMMOHEHTA C NPON3BOACTBA.

Kak c Hamu cBfizaTbCcA

TenedoH: 8 (812) 309 58 32 (MHOrokaHanbHbIN)
Pakc: 8 (812) 320-02-42

OnekTpoHHas nouTta: org@eplastl.ru

Aapec: 198099, r. Cankt-INeTepbypr, yn. KannHuHa,
Oom 2, kopnyc 4, nutepa A.
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